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Computer Applications Concepts 
Volume 6 

Word II – Office 2016 (and some earlier versions) 

 
Introduction 

 
Word is an amazing tool for working with all types of printed materials.  Anyone can use Word to produce 
a professional, easily formatted letter using basic tabs and line spacing.  This part of Word is simple to 
learn.  It is also easy to learn the basic Mail/Merge feature to send personalized letters to hundreds or 
thousands of people on a name and address list or perhaps just to select few who fit certain criteria. 
 
On the other end of the spectrum, Word can be used to create an interesting book or detailed report with 
multiple chapters, inserted charts and graphs, clip art and photos, interspersed outlines, cover sheet, 
generated index, table of contents, and even hyperlinks for online viewing.  Multiple people can edit and 
modify the document, and all the edits may be viewed at one time to update the original. 
 
In short, Word is incredibly powerful.  What Word is not, is intuitive. 
 
Word has been through many iterations designed to make it easier to navigate and use.  Often, there are 
multiple ways to accomplish a task, and the trick is to know all the ways and be able to pick the best and 
most efficient method.  However, there are a number of things that are hard to locate and negotiate if 
you are unfamiliar with the ribbons, tabs, task panes, dialog boxes, and toolbars. 
 
This book has been written as a sequel to our Computer Applications Concepts Volume 5 – Word I book, 
however, if you already have a basic knowledge of Word and are seeking to take your skills to the next 
level, this is the book for you.  The approach uses a simple tutorial format that provides a step-by-step 
guide through various functions and projects.  Students will be given the opportunity to put many 
individual skills together to gain a better understanding of how they interact. 
 
Written for Word 2016, this volume may be used with Word 2013, 2010, and 2007 as well.  The 2016 
version is much closer to the 2013 and 2010 versions, but there are some changes with 2016 as well.  
Several shortcuts changed, some features were relocated, and many graphics/dialog boxes were updated. 
 
NOTE TO TEACHERS:  There are many files saved through the course of this book.  It might be easier to 
track a student’s progress if a student's number or initials are appended to the file name so that they may 
be easily identified. 
 
The Appendix contains answer keys for the exercises in the book, and a Solutions CD is available for 
purchase with the actual documents used in presenting the elements in this book, as well as the exercises.
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Computer Applications Concepts 
Volume 6 

Advanced Word – Office 2016 
 
I. Starting Document 

A. The Concepts-6 Original document is available on the Solutions disk.  It is the same document 
that was used in the Concepts 5 booklet, and it was named Concepts-5 Original in that 
booklet.  Start with that document and rename it to be Concepts-6 Original. 

B. If you do not have access to this document, you will need to create it now, using Calibri, 12-
point font and the text below.  

C. Save it as Concepts-6 Original. 
D. Verify that the document is correct and protect it by going to the Review Tab and select 

Restrict Editing in the Protect group, and click to Allow only this type of editing in the 
document under the Editing Restrictions section, then scroll to select No changes (Read only). 

E. Close the document.  
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II. Styles 
Note: For Word 2016, the following Document Formatting will be found under the Design Ribbon.  For 
Word 2010, the following Document Formatting can be found in the Change Styles drop down menu 
under the Home Ribbon or in the Themes group under the Page Layout Ribbon.  The specific 
instructions and images will be for Word 2016.   

A. Styles is an easy way to create consistent formatting in a large document 
or a document that has several parts being created or edited by many 
people. 

B. Open a new blank Word document.  
C. On the Design Ribbon, click on the down 

arrow on the Themes icon to show the 
options depicted on the right. 

D. Flip through the Themes and notice what 
happens in your document as you scroll.  
Many Headings and Styles come in colors 
that are associated with a preset color 
theme. 

E. To see some of the color themes that are 
available, select the Colors arrow and click 
customize colors. 

F. We will now create a new color theme 
called Concepts-6. 
1. In the Name box type Concepts-6. 
2. Click on the down arrow for the Text/Background - Dark 1 color box. 

a. Select more colors, click on the Custom tab. 
b. Select Color model as RGB. 
c. Set the RGB colors to the following 

values.  Red: 0, Green: 32, and Blue: 107 
d. Click OK. 

3. Click on the down arrow for the Accent 1 
color box. 
a. Select more colors, click on Custom tab. 
b. Set the RGB colors to Red: 145, Green: 

127, and Blue: 252, and click OK. 
4. Click on the down arrow for the Accent 2 

color box. 
a. Select more colors, and click on the 

Custom tab. 
b. Set the RGB colors to Red: 126, Green: 

154, and Blue: 243, and click OK. 
5. Click on the down arrow for the Accent 3 

color box. 
a. Select more colors, and click on the 

Custom tab. 
b. Set the RGB colors to Red: 255, Green: 255, and Blue: 102, and click OK. 

6. Click on the down arrow for the Accent 4 color box. 
a. Select more colors, and click on the Custom tab. 
b. Set the RGB colors to Red: 255, Green: 204, and Blue: 102, and click OK. 
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J. Build a Resume with a template 
1. For this exercise, we will use a Template as a base and Quick Parts to modify it. 
2. Open a blank document. 
3. From the File Tab, select New, and then Search for Origin Resume and select it. 
4. Set your Style colors to Concepts-6. 
5. Make the following adjustments to the top box that is very thin (Not the Name box.) 

a. Highlight the dotted line (you may need to click just below and drag up to catch it), 
then right click and select Border Styles. (For Word 2010, highlight the dotted line 
and then select Page Borders on the Page Layout Tab.) 

b. For the style, select a style with two lines, make the color Red, Accent 5 from the 
Concepts-6 palette and set the width to 1 ½ point.  Use only a top border. 

c. Repeat the steps to put a double red line at the bottom line on the box at the bottom 
of the page. 

6. The first box of data is called the Resume Name Box. 
a. Click in the block and a 

Quick Parts tab will 
display at the upper left 
of the box.  

b. Click on the down 
arrow and you can see 
different options for 
the box. 

c. Leave this one as it is 
without a picture. 

d. Notice that the name 
beside the arrow 
matches the name of the computer.  It if is yours, great, if not, change it by typing 
over it. 

e. All of the items in the brackets [ ] can be edited by typing in them.  These are like a 
fill-in-the-blank form. 

f. Insert your personal information in the brackets.  Use a special character between 
the street address and the city. 

g. You can delete controls on this form.  If you do not have a web address delete the 
control and the line it is on. 

7. The main group does not have a specific name, but many of the items in it can be found in 
the Quick Parts, Building Blocks Organizer. 
a. Delete the Objectives section, just highlight and delete. 
b. Fill in the Education section as 

shown to the right.  Notice as 
you type an accomplishment 
and space down the arrow 
appears as you go.  It is part of a 
bulleted list.   

c. Copy the Skills heading and list 
below it, and paste another copy of these two lines below the existing lines. 

d. Change the words Skills in the first instance to be School Activities, and list the 
following activities: Student Council, Symphonic Band – Flute, and Basketball. 

e. Delete the Experiences section, assuming the student has no work history. 
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2. Right click anywhere in the chart area to select the Format Chart Area to make changes to 
the border around the entire chart. 
a. Select Fill & Line from the list. 

(1) Under Border, click on the Solid line radio button. 
(2) Select any color; we chose black. 
(3) Set the width to 2 point. 
(4) Click on the Close button to close the dialog box. 

3. Right click on the pie to select all pieces of the pie, and select Format Data Series. 
a. Click on Fill & Line, and click on the Solid line radio button under Border. 
b. Select a color; we chose black. 
c. Set the width to 2 point and close the dialog box. 

4. Create the title as shown with bold black type. 
5. Position the legend on the right and make each slice a different color. 
6. The chart should have a similar appearance as shown below. 

7. Save the document as Shapes and close it. 
 

K. The Links group has icons that enable using a Hyperlink to an external element, a Bookmark, 
or creating of a Cross-reference. 
1. To insert a hyperlink in your document, open Concepts-6 Original and save as Links and 

follow these instructions.  
a. Select the word Amethyst in the first paragraph. 
b. Click on the Hyperlink icon in the Links group of the Insert Ribbon. 
c. An Insert Hyperlink dialog box opens with Amethyst in the Text to display box. 
d. Click on the Browse the web icon to the right of the Look in box. 

(1) Search the web for Amethyst. 
(2) Click on a site and go to it.  We chose http://en.wikipedia.org/eiki/Amethyst. 
(3) Copy the address of the website, and paste it into the Address box at the 

bottom of the Insert Hyperlink dialog box.  
(4) Click OK. 

e. The word Amethyst will now appear in blue with an underline indicating it has a 
linking address. 

f. With your cursor, hover over the word and the web address will display in a 
temporary box. 

2. To insert a Bookmark in your document follow these instructions. 
a. Place your cursor at the beginning of the first paragraph. 
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6. Click on Design Mode in the Controls group of the 
Developer Ribbon, and the Properties icon immediately 
below the Design Mode icon will activate.  
a. Put the cursor to the right of Name and hit tab. 
b. Click on the Aa that says Plain Text Content Control 

when your cursor hovers over the icon.   
c. The box below appears with your cursor in the box. 

d. Delete the contents in the box and type the following: 
Name is Optional 

e. Highlight the text and hit CTRL-U to underline as shown to the right. 
7. Place your cursor directly in front of the word Male, and click on the down arrow to the 

right of the Legacy Tools icon in the Controls group of the 
Developer Ribbon and select the Check box icon in the 
Legacy Forms options. 
a. Enter two spaces between the box and the word 

Male.  (Note that the box may be shaded.) 
b. In the same drop-down icon area, click on the Form 

Field Shading icon to turn shading off. 
c. Double click on the check box to open the Check Box 

Form Field Options dialog box. 
(1) Click on the radio button for Not Checked. 
(2) Click OK. 

8. Place your cursor directly in front of the word Female, and repeat the process to add a 
check box in front of Female. 

9. Repeat this step for all of the Age groups. 
10. The last question will use check boxes also, but first put the list in alphabetical order. 

a. Selecting all of the items in the list, go to the Home Ribbon and select the AZ sort 
button from the Paragraphs group. 

b. Sort by Paragraph in ascending order. 
c. Insert check boxes in front of the name for each of the clubs.  Be sure to put two 

spaces between the box and the club name, and be sure the radio button for Not 
Checked is selected for each.  

11. Now put in drop-down list controls for Major and Year. 
a. With your cursor to the right of Major, hit tab. 

(1) Click on the Drop-Down List Content Control icon in the Controls group of the 
Developer Ribbon. 

(2) Replace the wording in the box with the following: Select a major subject 
(3) With the cursor in the box, click on the Properties button in the Controls group 

and a Content Control Properties dialog box opens. 
(a) In the Locking section of the box, click the box by Content Control cannot 

be deleted.  (This will allow changes to be made to the contents of the 
control, but deleting the control itself cannot be done.)  
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XII. Exercises 
A. Exercise 1 – Flower Shop Report using the following specifications. 

1. This report will use several elements that have already been discussed. 
2. This exercise is designed to give an idea how to put the elements together and modify 

things to create a report that suites your needs. 
3. The report will include a cover sheet with a watermark, a table of contents, a table of 

figures, headers and footers, and two graphs. 
4. Open a new document with 1" margins and create a cover 

page with a watermark. 
a. Add a watermark to print on the cover page. 

(1) Search for roses in the Online Pictures and select 
the picture to the right or one similar to it.  

(2) Be certain that the background is white. 
(3) Click on the picture in your document and save it 

as a picture in a location you can find later. 
(4) Delete the picture in your document. 

b. Insert a watermark using the picture saved. 
(1) Scale should be Auto, and make sure the box for Washout is checked.   
(2) Click OK.   

c. From the Quick Parts drop-down list on the Insert Ribbon, insert the Filigree 
template from the Building Blocks Organizer as the cover page, and make all the text 
Bookman Old Style.  (Note: In Word 2010, if Filigree is unavailable, choose a 
different cover page with a white background so the watermark will be visible.) 

d. Make the text in the title box 28 point font, the subtitle box 20 point font, and the 
author/company name, address and date boxes 14 point font. 
(1) For title, use The Flower Shop Sales Report 2018. 
(2) For subtitle, use Annual Sales Report for the Texas Region. 
(3) For author/company name, use Macon M. Growle. 
(4) Add the current date and delete the extra company address boxes. 

5. Add Headers and Footers. 
a. Use Bookman Old Style 8 point type and right justify the following header on all 

pages except the cover page:  Sales Report 2018 
b. Add a footer with the same formatting at the header shown as:  Flower Shop 
c. Close Header and Footer and move your cursor back into the document. 

6. Create the body of the Report. 
a. Select the color theme Concepts-6. 
b. Center the title, Texas Region Sales Report, in the Heading 1 Style, and change to be 

16 point font, and Dark Blue, Text 1 color.  
c. Double space after the title. 
d. Enter the following text, left justified with Heading 2 Style and make the font bold, 

underlined, and Dark Blue, Text 1 color: 2018 Sales 
e. Select 6 Normal Style and type the following paragraph without indentation under 

the 2018 Sales heading.  
 

As you can see from the graph below, there is a peak in flower sales in the 
second quarter.  This is most likely due to Mother’s Day (May) and the increase 
in the number of weddings taking place in June.  
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5. Fifth merged document 

 
6. Exercise 3 – Document showing Merge Field Codes   
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